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LESSON 1:

THE BENEFITS AND BASICS OF EXCEL



’ ' Why Use Excel?

e Excel can be an easy way to review significant
amounts of data to identify particular issues or
situations.

e Excel can be used to check calculations
performed within your CAMA system to verify
accuracy.

e Excel spreadsheets allow analytical capability

without requiring your software vendor to
program a specific analysis for you.



’ ' Why Use Excel?

e Excel provides a generally universal method for
sharing data and information with others.

e Excel can be used to prepare custom handouts,
charts, and reports to highlight particular
findings.



e In Excel 2007, you can open files created in Excel 95
through Excel 2003.

 You can open and edit older workbooks and share files
with people who don’t have Excel 2007.



' Microsoft EXCEI

e Common versions:
— Excel 2007 (current version)
— Excel 2003 (older version, still popular)
— Excel 2010 (newest version, not very popular)

e While this discussion will focus on Microsoft Excel 2007,
some of the capabilities discussed in this class would
also be present in other spreadsheet packages.
Typically, the Help option can be used to find particular
functionality.



3 Excel 2007 versus Excel 2003

e Row — Horizontal array of data.
— Signified by numbers — Row 1, Row 2, etc.
— Maximum number of rows:
e Excel 2003 - 65,536
e Excel 2007 -1,048,576

e Column —Vertical array of data.
— Signified by letters — Column A, Column B, etc.
— Maximum number of columns:
e Excel 2003 — 256
e Excel 2007 — 16,384



Office Button
Quick Access Toolbar

The Menu

— Home Tab

— Insert Tab

— Page Layout Tab
— Formula Tab

— Data Tab

— View Tab

— Help Tab



Quick Access Toolbar

Dn ) ¥
2
Home Insert Page Layout Formulas Cata Review Wiewr
45 From Access Ilﬁ |31 pu. :l_aj Connections al a7z ]?
| .r".l.l"h

4 From Web =1 =1 ; ’ %

e From Other Existing Refresh I L] sort Filter .-

;[ From Text Sources - Connections All = Tl B . Advanced

Get External Data Connection fgdd ko Quick Access Toolbar
Cuskomize Quick Access Toolbar.. .

e The Quick Access Toolbar is above the menu when you first start
Excel 2007. There, commands are always visible and near at hand.

e To add a command to the Quick Access Toolbar, right click on the

command and click “Add to Quick Access Toolbar”. 0



Lesson 2: Hands-On Exercises:

Commands and Functions
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Sample Data

e |In order to complete these hands-on exercises,
vou will need the Excel Excellence.xlsx file
downloaded to your computer.

e While we are using this file in our examples, the
functionality discussed could be used with other
files created by you or generated by your CAMA
system.

12



Helpful Tips - Short Cuts

Some commands can be done in Excel by using a
keyboard shortcut.
Most keyboard short cuts involve the Ctrl Key.

Common short cuts:
— Copy- Ctrl C

— Cut - Ctrl X

— Paste - Ctrl V

— Undo - Ctrl Z

— Save - Ctrl S

— Select All - Ctrl A

— Find - Ctrl F

13



Freeze Panes

e Freeze Top Row so column headings are always available
— Ensure Column headings are the top row of your spreadsheet
— Goto View Tab
— Select Freeze Panes
— Select Freeze Top Row

= 9 - &)+ Land.xls [Compatibility Made] - Microsoft Excel -8X
- Home Insert Page Layout Formulas Data Review View Acrobat e - T X
E===3 g , = ™ B || 2 New Windoa B B
£t j L1l Page Break Preview e I'\_: l._‘ | Ca NewWindow [ | 11| O IE:I_“IJ n:|
1G] Custom Views || -~ | Y = oo = Amange Al T |2 m = E=7
(Mormal| Page Show/Hide | Zoom 100% Zeomto |\m—=———"7 _ | . Save Switch Macros
Layout = Full Sereen - Selection |;H Freeze Panes™|_| | 414 | Workspace Windows - -
Workbook Views Zoom e :'_—I Unfreeze Panes ||| Macros
y ' B Unlack all rows and columns to scroll
E5 TN J= | 530410207110000013 - through the entire worksheet, ¥
A B O == Freeze Top Row
1 LAND_ID ASSESSMENT_YEAR | COUNTY_NUMBER PARC :l f;ep thhe ttr?p raﬂstiﬁle wh::ehscrflliﬂq '] LAND_LOT_TYPE_CODE | ACT
2 149254676 2010 53 T e F
3 | 149254677 2010 53 2= Wbkt
. ] Keep the first column visible while scrnII|n| Freeze Top RUW
- 149354678 2010 53 ! through the rest of the worksheet, L




e Ctrl—F or on Home Tab (Binoculars)

e Find Land ID Number 190117305
—  Press Ctrl-F or press the Find button on the Home Tab
— Type 190117305 in the Find What box
— Select Find Next or hit Enter

| ; General - fﬂ' Conditional Formatting ~ | 5= Insert ~ X - A?' \}a
baf + |||% = % 9 ||| [ Format as Table ~ o Delete ~ j* Z
el i Find &

L} = A A — S':lrt&'.

RN
a1

1§

.'= Find and Replace 7] x| Bt Ty

Editing Iﬁ Eind...

Hac | Replace..

"o

Find I Replace |

Find whak: I ;I | Mo Format Set Farmat... |v| = | GoTo..
] PIL_PRO Go To special...
\Within: ISheet ~| I match case S
[ Match entire cell conkents Comments
Search: |By Rows -
Conditional Formatting
Loak in: IFn:nrmuIas vI Cpkions == |
Constants

Data Walidation
Find All | | Eind Mexk I Close |

Lg | select Objects
21780 21780 1 43560 "EQ Selection Pane...

3]

21780 32670 15 85340 'r|



Replace

Located in same place as Find

Ctrl — F or on Home Tab (Binoculars)

Replace Year 2011 with Year 2012 Select Year column
Press Ctrl-F or press the Find button on the Home Tab
— Type 2011 in the Find What box

— Type 2012 in the Replace With Box

— Select Replace or Replace All

= == General - ;-:__gll Conditional Formatting - | 5= Insert - - Aﬁ;? : ?a
E==- |% - % | [G%FormatasTable- 3 Delete ~ || [g] - Z,
= i . Sort & |Find &
=\ aa| <0 .00 = rall Shelac ~ | Enrmat + 3 Fifter - |Select ~
Find and Replace i Editind 33 | Fina
Find...
Find Replace | 3. Replace..
Find what: I LI | Mo Format Set | Format. .. |-.-| = | GoTa..
OIL_PRO .
Replace with: I | | Mo Faormnat Set | Format. .. |-.-| Go To Special...

Formulas
Within: ISheet vI [ Match case
[ Match entire cell contents Comments
Search: IBv Rows vI

LConditional Formatting

Lok, in: IFu:urmuIas vI Options << | Constants

Data Validation
Replace Al I Replace | Find All I Find Mext I Close I T
g elect Objects

21780 21780 1 43560 LEI';& Selection Pane... 16




Find and Replace —~Workbook

e Find and Replace feature can work within entire Excel
Workbook

e Find Land ID Number 190117305 in Workbook
—  Press Ctrl-F or press the Find button on the Home Tab

- Clle Opt|0n5 =1 izeneral - fﬁCnnditinnal Formatting = 3= Insert = z - A? \j’ia

_ SE|€Ct llworkbook” af~ | $ - % | G5 Formatas Table - % Delete - -_;Iv 5?;‘;& .

) ] | ol il %CE“smgsv :anrmat' 27 Filter~ Select v

From Within box
frindandReplace T | —
— SelectFindAllor = ., | Reptce | N
Flnd NeXt 1 Find what: | j |N|:| Format Set | Farmat... |v| r| SOIL P
Within:  [sheet w| I Match case

[ Match entire cell contents

Search: Sheet

diforkbook s
Look in: IFDrmuIas vl Opkions =+ |

Find &l Find Mexk Close
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Available on Home Tab and on

Data Tab

Sort by Land Lot Type Code

—  Select full data range

—  Select Custom Sort

—  Select
LAND _LOT_TYPE_CODE in
the Sort by dropdown box

Multi level sorts can also be done

in Excel

—  Click on Add Level

— Select LOT_NUMBER from
the dropdown box

—  Click OK

e Layout

ns

A
F
F
A

Formulas Data

l Sort | Filter

Review

=]
+

EEE)

Textto  Remove
'_’,?—Ldvanced Columns Duphcates £ ) What-If Analysis =

View

Acrobat
= = =Y Data Validation ~
Ln Consolidate

% Group ~ =

+# Ungroup *

3 subtotal
21

J;[ Add Level >( Delete Level =2 Copy Level Options.., [¥ My data has headers
Column Sort On
Sort by v| |'|,|'a||_|es vl AtoZ v

LAND_ID
ASSESSMENT _YEAR
COUNTY_MUMEER.
PARCEL_ID
PARCEL _NUMBER
LOT MUMBER.

ACTUAL_FRONTAGE
EFFECTIVE_FRONTAGE
EFFECTIVE_DEPTH
BASE RATE

oK Cancel

o
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Available on Home Tab and on

Data Tab in same place as Sort

Filter for Land Tot Type Code 91

— Select Row 1

— Go to Sort & Filter on Home
Tab or to Filter on Data Tab

— Select Filter

— Go to drop down arrow on
Land Lot Type Code

— Uncheck all Land Lot Type
Codes other than 91

— Hit OK

d9-a ) Land.xs [¢

Home Insert Page Layout Formulas Data
|Za] Connections | 4 | Bo = Clea
4 £ Al
2] S| 24 212 \
il Refresh - Z] Sort Filter | .,
A~ == Edit Links A«lr _T!‘:?Ad'l.ra
Connections Sort & Filter
H4 - &0
E F e

CEL_NUMBEF ~ | LOT_NUMB ~ | LAND_LOT_TYPE_COL ~ | A

02071 4| sortAtoz

:gzgi Zl| sortZto A -

02071 sort by Color >

oDzoso| &

02080 h

02080 Text Filters >

02090

02100 -] (Select All)

02100 ~[]1

02110 g ‘; -
Land

_Land =
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e Available on Home Tab and on Data Tab in same
place as Sort and Filter

e Clear filter from Land Lot Type Code column

1. Go back to drop down box on top row of Land Lot

Type Code
a) Select All
b) Clear Filter

2. On Home Tab and Data Tab, option available for
Clear

20



3 Helpful Tips — Multiple Rows

e Edit more than one cell, row or column at a time by
using the Ctrl Key

e Add commas to Appraised Value and Square Feet
— Highlight Appraised Value
— Hold down the Ctrl Key and highlight Square
Feet

— Change columns to include commas

21



) Helpful Tips — Table or Array

e Select an array of data or an entire table of data by
using the Shift Key

e Select all data in the Land File Worksheet
— Select Cell A2
— Scroll to end of data, Cell Y250
— Select Cell Y250 while holding down the Shift
Key

22



: i Helpful Tips - Worksheets

e Edit more than one Worksheet at a time by using
the Ctrl Key

e Change Column B in the Land File and in the Chart

Data Worksheet to a yellow fill
— Highlight Column B in the Land File
— Hold down Ctrl Key and highlight the Chart Data

Worksheet tab
— Keep Ctrl Key down and fill Column B

23



2 Text To Columns

Located on Data Tab
Excel is able to divide values from one cell using the

Text to Columns function.
— Excel can divide a cell based on two general features

e Fixed Width
e Delimited with a specific character (spaces, commas,

semicolons)

Go to Text to Columns Worksheet
— Highlight Column A

— Click on the Text to Columns Command
— Delimited option

— Click Comma

— Click OK
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® Combine Values from Two Cells

We can combine values using the following formula in

another cell.
e Excelis able to combine values in cells

e For example:
— |f we have two columns, one with first name and another with

last name.
e Example: We have the first name in cell A1 and last name in B1

e We want first then last with a space in between, then the

following formula combines the two.
- =A1&"” “&B1
e Or, if we want last name then first name with a comma

between, the following formula works.
- =Al1&”, “&B1
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b, Conditional Formatting

e Available on Home Tab.

e Next few screens walk through pre-defined
options.

e You can also get more specific through New Rule
or Manage Rule options.

26



Conditional Formatting

11T =y 2 Autos
e == [
= B =il Greater Than...
_onditional | F t Cell Insert: Belete F t :
Formatting |as Table - styies~ |+ -« | <2aar o Less Than...
- _—'EJ Highlight Cells Rules * __Iﬂl Greater Than... = () BEtween...
8 _ﬂul Top/Bottom Rules  # _Iﬂ] Less Than... LT ¢ Equal TO"'
| = = B o TeXt that
E Data Bars g ﬂ Between... .
] | Contains...
E Color Scales g =L Equal To... .
== e A Date Occurring...
_i Icon Sets k —_Igt! Text that Contains... _ () Duplicate Values."
| e R —% A Date Occurring...
_-_'__',.- Clear Rules po| T
i5d| Manage Ruies.. 7y é Duplicate Values...
72 Mare Fules...
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Conditional Formatting

: —_— T Au
5y sl o Top 10 ltems...
[
_onditi Bl F t Cell I i Belete F i -
Formatting ~las Table - styies= |+ + v | <2a o Top 10%...
T i_ells
= 2], maniiant cens Rutes > L e Bottom 10 Items...
= 0
5 _ﬂl{l Top/Bottom Rules  » iLll Top 10 Items... E ¢ BOttom 10/0"'
fi= = o Above Average...
E Data Bars g —ﬂ Top 10 %e...
_ e Below Average...
E Color Scales 4 _.Jﬁ Bottom 10 Items...
::E Icon Sets b ___4% Bottom 10 %...
b | New Rule.. i:U Above Average...
_"_'_l,',a Clear Rules k B E]
{5] Manage Rules... i _._JE i A
72 Mare Rules..,

?2 ] 28



%8 Conditional Formatting

e Highlight Duplicate Values T (e o w—
T g g p 15:5 fiﬁ :jd ;"Delete' Ev ‘%? L:?
in the Land ID Column Fondtions romat  Cel || iromat~ || @+ Sort P
— Select the Land ID Column | sovsmcannis s | =] oemn. |

— Go to Conditional | Ay ropmotommues | [l e han.
Formatting B oota sas | B petween.

— Select Highlight Cell Rules | B corsaes | =] sovarre.

— Select Duplicate Values... | fijwmse 2] sommconsmn. |

— Can customize format of = wevee. -
the rule = [—— _

=1 Duplicate Values...

- H |t O K More Rules...
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Conditional Formatting

j§|
Conditional ,
Formatting = as Table = Styles = || fa-| Format ~ 27 Filter~ Select~

” =t || g=Insert ~ z - :
» g g
T Delete - | (@]~
Format Cell _— Sort & Find &

e To clear Conditional

9 _—"gl Highlight Cells Rules = — Formatting
] : o ¢ — Go to Conditional

'ﬂ | Top/Bottom Rules L4

== CREAGE | SQUARE_FEET |s0IL ID| soiL
- ons o0 Formatting
E‘ peta Bars " 04 17424
= [ } | 02303 10032 - SeleCt Clear RUIES
I — — Select Clear Rules from
_.:E._ Icon Sets 3 | e T [

Selected Cells or Clear
= | Mew Rule...
_'f'_lb Clear Rules 4 Clear Rules from Selected Cells Rules from Ent|re Sheet
L8| Manage Rules... Clear Rules from Entire Sheet .

as applicable
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Remove Duplicates

Data Review View Acrobat

e Located on Data Tab e e ey
° i Reappl === = ;Ei:l Consolidate - Ungroup = E
. 7 Textto Remove e : r
el I Iove u p Ica e 2 Advanced || Columns Duplicates (B9 What-If Analysis ~ ﬂjSubtotal
[ter Data Tools Outline L]
Records 2x]

To delete duplicate values, select one or more columns that contain
duplicates.

— Select full data range
— Select Remove
Du plicates I~ ASSESSMEMT_YEAR
. ¥ COUNTY_NUMBER
— Select which columns s [7 pecam

¥ PARCEL_NUMBER

contain duplicates | e N
e Toensurethe fullrecord T [ iarome,

¥ EFFECTIVE_DEFTH

is an exact duplicate, = i
select all columns = —

— Hit OK

v My data has headers

5= Unselect Al |

Columns |
¥ LaND_ID

el
wow|ww |
W W | @
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e Before printing

— Determine the purpose for your printing and try to
arrange your data so you get the exact printout you
need.

— Print preview before printing to ensure the final
printout will be useable.
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e Page Layout Tab
e Page Setup

Customize size and layout of paper
Center on page

Add headers and footers
e Title of worksheet

e Page numbers

e Prepared by

e Any disclaimers or notes

e Print Titles

Customize column or row headings to be repeated on
each page during printing.
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SR8 Functions

e Excel has a large number of built-in functions.
e To use these pre-defined functions, you need to be

cognizant of the specifics of the function:

— What is the function designed to do

— What cells need to be included in the calculation

— What criteria must you specify for the calculation

— In what order are these cells or criteria required to be

entered
e Formula Dictionary on Formulas Tab
— Insert Function

34



%) Simple Cell Mathematics

Mathematical formulas can be performed in Excel that do

not require a pre existing function.

— Variety of different mathematical functions: addition (+), subtraction
(-), multiplication (*), and division (/)

For example, add Cells E2 and E4
Type =

— Click/type Cell E2

— Type +

— Click/type Cell E4

- =E2+E4

Constant values, instead of a cell reference, can also be used

For example, multiply E2 by 55%

Type =
— Click/type Cell E2
— Type *0.55
— =E2*0.55
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# Functions

Common Functions

SUM — Adds together selected values

AVERAGE — Calculates the average of selected values
MAX — Identifies the maximum value in selected
range

MIN - Identifies the minimum value in selected
range

ROUND — Rounds numbers to a particular decimal
point precision

COUNT - Counts number of values in selected range

36



Functions — SUM & AVERAGE

Sum Appraised Value for all records

— Go to bottom of the Appraised Value column
— Incell below data, type =SUM(

— Specify range to be included in calculation

—  Close formula with an end parenthesis

— Hit Enter

—  =SUM(L2:L250)

Determine Average of Square Footage

— Go to bottom of the Square Footage column
— Incell below data, type =AVERAGE(

—  Specify range to be included in calculation

—  Close formula with an end parenthesis

— Hit Enter

—  =AVERAGE(N2:N250)
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Functions — MAX & MIN

ldentify Maximum Value for Acreage

— Go to bottom of the Acreage column

— Incell below data, type =MAX(

— Specify range to be included in calculation
—  Close formula with an end parenthesis

— Hit Enter

—  =MAX(M2:M250)

ldentify Minimum Value for Base Rate

— Go to bottom of the Base Rate column

— Incell below data, type =MIN(

—  Specify range to be included in calculation
—  Close formula with an end parenthesis

— Hit Enter

—  =MIN(K2:K250)
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ROUND

Go to cell right below average calculation
Type =ROUND(

Select cell to be rounded

Insert a comma

|dentify decimal point precision
e 0=nodecimals

e 2=two decimals

e -2 =round to nearest 100

Close formula with an end parenthesis
Hit Enter
=ROUND(N250,0)
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Functions - COUNT

Count the number of records with a Soil Productivity

Factor

— Go to bottom of the Soil Productivity column
— In cell below data, type =COUNT(

— Specify range to be included in calculation

— Close formula with an end parenthesis

— Hit Enter

— =COUNT(P2:P250)
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, Functions

e More Advanced Functions:

IF — Checks for the existence of the specified
condition and returns different values if the
condition is true or false

SUMIF(S) — Adds values together if they meet a
certain condition(s)

COUNTIF(S) — Counts number of values in a selected
range if they meet a certain condition(s)

VLOOKUP — Retrieves information from a table,
based on a unique identifier

41



Functions - IF

e |dentify records with Acreage greater than 1
— Go to empty column — Column Z
—  Type =IF(
— Define criteria
e Acreage greater than 1
— Insert comma
— Insert value if true
— Insert comma
— Insert value if false
— Close formula with an end parenthesis
— Hit Enter
— Drag or fill down formula down cell
— =|F(M2>1,TRUE,FALSE)



Sum Appraised Value if the Acreage is greater than 1

Functions - SUMIF

Select an empty cell next to Column Z
Type =SUMIF(

Define range to be included in calculation
e Columnz

Insert comma

Insert criteria
e  “TRUE”

Insert comma

Insert value to be summed

e Appraised Value

Close with an end parenthesis
Hit Enter
=SUMIF(Z2:2250,"TRUE",L2:L250)
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Count the number of records with Acreage greater

; ' Functions - COUNTIF

than 1

Select an empty cell next to Column Z
Type =COUNTIF(

Insert range to be counted

e ColumnZz

Insert comma

Insert criteria

e “TRUE”

Close with end parenthesis

Hit Enter

=COUNTIF(Z2:2250,"TRUE")
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Functions - COUNTIFS

Count the number of records with Acreage greater than 1 and that have
a Land Type Code of 91

Select an empty cell next to Column Z
Type =COUNTIFS(

Insert 1%t criteria data range
—  ColumnyY

Insert comma

Insert 1%t criteria

- “TRUE”

Insert 2"d criteria data range
—  Column G

Insert comma

Insert 2" criteria

- "91”7

Close formula with a)
=COUNTIFS(Y2:Y250,"TRUE",G2:G250,"91")
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3 Functions - VLOOKUP

e The syntax for the VLOOKUP function is:
= VLOOKUP ( lookup value, table array, col index num , range lookup )
e |ookup _value: The value you want to find in the first
column of the table array.
e table_array: This is the table of data that VLOOKUP
searches to find the information you are after.
The table _array must contain at least two columns of
data. The first column contains the lookup values.
e col_index_num: The number of the column in the
table _array that contains the data you want returned.
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Functions - VLOOKUP

e Using the parcel number, pull the taxing district from the Parcel File
Worksheet of the records in the Land File Worksheet
— Insert a column between PARCEL_NUMBER and LOT_NUMBER
—  Type = VLOOKUP(
— Reference the lookup value
. PARCEL_NUMBER, E2
— Insert comma
— Reference the table with the requested information
. Select the whole Parcel File table
- Insert comma
- Reference the column number of the data you want to retrieve
. STATE_ASSIGNED_TAXING_DISTRICT, column number 9
- Can use permanent call references to create one formula and drag down
— SorF4
- Determine what needs to be permanent in the formula
- Add comma and enter “FALSE” (this returns the exact value)
- Insert comma and Close formula with an end parenthesis 47
—  =VLOOKUP(E2,5A$2:5BM$131,9,FALSE)



Functions — More Available

Insert Function

Seatch For a funckion:

O select a cateqory: | Mast Recently Used W

Select a function:

AYERAGE
IF
HYPERLIME
COUMT
M

SIM

SUM{number1 ,numberz,...)
Adds all the numbers in a range of cells,

Help on this function [ K ] [ Cancel

To see all the other functions:

N

Excel offers many
other useful
functions, such as
date and time
functions and
functions you can
use to manipulate
text.

Click the Sum button in the Editing group on the Home tab.

Click More Functions in the list.

In the Insert Function dialog box that opens, you can search for a

function.
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% Microsoft Excel Quiz 1

Quiz 1, Question 1:
Which keyboard short cut is used to Select All?
A. CtrlZ

B. CtrlA

C. CtrlS
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#% Microsoft Excel Quiz 1

Quiz 1, Question 1:
Which keyboard short cut is used to Select All?

Answer:

B. Ctrl A
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% Microsoft Excel Quiz 1

Quiz 1, Question 2:

Conditional Formatting is used to remove duplicate records.

1. True

2. False

51



#8 Microsoft Excel Quiz 1

Quiz 1, Question 2:
Conditional Formatting is used to remove duplicate records.

Answer:

False

Conditional formatting helps to identify duplicate records, but the
Remove Duplicates command is used to remove duplicate records.
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% Microsoft Excel Quiz 1

Quiz 1, Question 3:

What is a function? (Pick one answer.)

1. A prewritten formula

2. A mathematical operator
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i Microsoft Excel Quiz 1

Quiz 1, Question 3:

What is a function?

Answer:

A prewritten formula

Functions are prewritten formulas, such as SUM, that save time.
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; ; Microsoft Excel Quiz 1

Quiz 1, Question 4:

A dollar sign used in a formula signifies that a cell has been set
to be a permanent reference.

1. True

2. False
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3 Microsoft Excel Quiz 1

Quiz 1, Question 4:

A dollar sign used in a formula signifies that a cell has been set
to be a permanent reference.

Answer:

True
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Microsoft Excel Quiz 1

Quiz 1, Question 5:

What is the correct formula to round 29,128.6547 to the
nearest hundred?

A. =ROUND(29,128.6547)
B. =ROUND(29,128.6547, 2)

C. =ROUND(29,128.6547, -2)

57



............
T

i) Microsoft Excel Quiz 1

Quiz 1, Question 5:

What is the correct formula to round 29,128.6547 to the
nearest hundred?

Answer:

C. =ROUND(29,128.6547, -2)

Formula (B.) would round to the nearest hundredth.
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Hands-On Exercises:

Charts and Pivot Tables
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e Excel provides a wide range of charting options on
the Insert Tab.

— Column Charts

— Pie Charts
— Bar Charts
— Line Charts
nulas Data Review View Developer AL
. - M e 8D
Column Line Area Scatter Other
- - - - L. - Chan51

- & F.
khaﬂa 60




3 Charts — Scatter Plot

* DesignaScatter Plotof gy o &b = g 000D
the Appra|sed Values |n CDI,L.Imn Li:1e F'le Efr .ﬂ-.:-rza Scaj:ter Cﬁ’;l:tesrv Hype
the Land File Charts Scatter
Worksheet / F - [ Il
— nghllght the |  LoT_numBER ] LAND_LOT E I

01 191
APPRAISED VALUE 01 151
01 191 ' '
column - .
— Gotolnsert Tab 5 i =
— Select Scatter -+ T M| A4 Chart Types..




3 Charts — Scatter Plot

Land Appraised Values

120,000

100,000 .
.
80,000 ¢
o S
XS
60,000 ¢
o« ¢ ® <>
40,000 *
iy w0 YR N o 00
© “w ¢
20,000 —’0—0—“—%70 * % { ™ o
oo O o +3P ¢ *

e Can use Design, Layout and Format menus specific to
the chart to change how the chart is presented

e Update chart title in chart directly
e Land Appraised Values
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% Charts — Column Chart

e Design a Column Chart showing Appraised Value by
Land Lot Type

— Create chart data

e Copy (right click or Ctrl-C) Land Lot Type Code column and
paste (right click or Ctrl-V) to Sheet 2

e Remove duplicates (Data Menu)

e Create SUMIF statements to add Appraised Value by Land
Lot Type Code

— Determine what needs to be permanent in the formula

—  =SUMIF('LandFile'!$SGS$2:5GS250,Sheet2!B2,'LandFile'!ISLS2:
SLS250)
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i Charts — Column Chart

ulas Data Review View SAcrobat

e Design a Column Chart

. . R ﬂ et D
showing Appraised Value by  coumn une  mie s ares scareer otner
Land Lot Type (continued) i
— Add Appraised Value heading ‘Lﬂ_ﬂ Imfl] | .

on Sheet 2 — = | e
— Select chart data on Sheet 2 J‘tﬂfi 193 lﬁﬁ j'ﬂ
— GotolnsertTab 1| (1A ] 1A ad
— Select Column Chart—2-D e
Column b JaA ] |JAA] Jed
ihis) [1aA] AA] [ Jash

gl | A1 chart Types...
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3 Charts — Column Chart

Appraised Value By Land Lot Type

2,621,680

352,280

17,500 3,210 12200 0 12,470 33,480 . 61,870 47,800 7,520

1 4 5 6 9 21 41 42 72 91 F

e (Can use Design, Layout and Format menus specific
to the Chart to change how the Chart is presented

— Add Appraised Value totals to top of columns

e Update chart title in chart directly
e Appraised Value by Land Lot Type
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) Charts — Bar Chart

e Design a Bar Chart showing Appraised Value by Land Lot
Type IF Acreage is greater than 1

— Create chart data

e Create a column for AV Acreage greater than 1 by adding
heading in Column C of Sheet 2

e Create SUMIFS statement to add Appraised Value by Land
Lot Type Code if Acreage is greater than 1

— Determine what needs to be permanent in the formula

—  =SUMIFS('Land File'!SL$2:5L$250,'Land
File'!SYS$2:5Y$250,“TRUE", 'Land
File'!SGS2:5GS250,Sheet2!B2)
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3 Charts — Bar Chart

. . A —= = -
e Design a Bar Chart showing @l ¢ & =5y -2 )
Column  Line Pie Bar Area Scatter Other
Appraised Value by Land S Sharts
Lot Type |IF Acreage is E .% = =
greater than 1.00 sisedvalue o bar
i = (i
(continued) 2 ||== | | |28
— Select chart data on Sheet 2 00910l cytinder
o || | [dmn_] [ ummm
— Goto Insert Menu e = ==
— Select Bar —2-D Column  — . |
309530 :" :J;::F It
i Pyramid
L= === ===
il | AN Chart Types...




3 Charts — Bar Chart

Appraised Value by Land Lot Type,
Acreage greater than 1.00

91
72
42
41
21

309,530

128,090

= B Uy W

e (Can use Design, Layout and Format menus specific to
the Chart to change how the Chart is presented

— Add Appraised Value totals to the end of the bars

e Update chart title in chart directly
e Appraised Value by Land Lot Type



Subtotal

Located on Data Tab
Subtotal Appraised Value and
Acreage by Parcel Number

Select full data range

Select Subtotal button on Data
Tab

Select PARCEL NUMBER in drop
down box for At Each Change In
Use Function SUM

Check Appraised Value and
Acreage as columns to Add
subtotals to

Hit OK

e EE R

Group Uagroup Subtotal

-

Cutline =
Bsibiotal  EE]
4k each change in:
] IPARCEL_NLIMBEF{ =] ]
Y Use function:
I ISum j
I Add subkokal ko
' ACTUAL _FROMNTASE -]
- EFFECTIVE_FROMTAGE
d r EFFECTIVE_DEPTH _|

[~ BASE_RATE
¥ APPRAISED YALUE

v Replace current subkotals
[ Page break between groups
v Summary below data

Remowve All 0] 4

Cancel
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Subtotal

e To remove the Subtotal =5 =5 4 | -

Group Ungroup Subtotal

— Highlight the entire o i .

spreadsheet flsubtotal __________________ EEQ

&k each change in:

— Go to the Subtotal I Jparce_sumeer

U=ze Function:
ISum

add subkokal ko

[ ACTUAL _FROMTAGE
[ EFFECTIVE_FROMTAGE
[~ EFFECTIVE_DEPTH

[ BASE_RATE

¥ APPRAISED WALUE

4]

Kl

command on Data Tab

L B

— Click on Remove All

o Replace current subtotals
[T pPage break between aroups
v Summary below daka

Eermowve ol ] I Cancel
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Pivot Tables

e Open the Parcel File Worksheet .

e Make sure each column has a heading, as it will be
carried over to the Field List.

e Make sure your cells are properly formatted for
their data type.

e Highlight your data range.
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Pivot Tables

o e e e 2% e Click the Insert tab.
e Select the PivotTable
W e ottt Ea] button from the Tables
4 group.
o = e Select PivotTable from
— the list.
hrhwh :j;t'“e Eieoafintenaisiai ot e Double-check your
o s = Table/Range.
[ o ] w= | o Selectthe radio button
for New Worksheet.

e (Click OK.

TablejRange: | TE s

o m T N R N R T = T R

= | =
=]
»!
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Pivot Tables

PivokTable Field Liskt a4

e A box with the data fields will 7 -

“hoose Fields ko add to repork:
A FPARCEL_ID .

a p pea r- [1ASSESSMMEMT _YVEOR T

- =M TY _MUMEBER.
e (Click on the check boxes of the [ PARCEL HEADER_RECORD._ 1D
fields you want to include in your \SZrae rouwmsmme. mmecn .
ADISTRICT _MRMUMBER.
table. 0 Sare_AostaneD prTeIcT_puMec

CCURREMT &% ToTal AR

® Drag the deSi red fields to the I CURREMT _&a%w_ToTal  IMPROYWEMERTS

Ay _ToTal_LaMD_aD_IMPROVEME, . .

areas below to form your table ClAv FES LAND ANE LOTS —
. Drag Fields betveeen areas belovae:

_— Report Fllter “w FRepork Filker 1 Column Labels

— Row/Column Labels

— Values
e A table of the data will appear on
the spreadsheet.

L1 PRow Label=s = walue=s

Defer Layouk Lipdake ILpdate
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Pivot Tables

Create a Pivot Table using the Parcel File Worksheet, showing AV
Total Land and Improvements by Property Class Code and State
Assigned Taxing District

—  Click on the Property Class Code field & drop into the columns box

—  Click on the State Assigned Taxing District Field & drop into rows box

—  Click on AV Total Land and Improvements and drop into values

A B C D E E ‘W PivotTable Field List -
4 =
= Choose fields to add to report: o
3 [Sum of CURRENT_AV_TOTAL_IMPROWVEMENIColumn Labels, - . .
4  Row Labels ~ ool 002 003 (blank) Grand Total [ ASSESSMENT_YEAR =]
5 [100 - - - [0 COUNTY _MUMBER
& |101 65,000 2,184,500 2,249,500 O PARCEL_HEADER_RECORD_ID ‘l
7 |199 52,800 12,900 65,700 [ PARCEL_MUMBER
- gy 560,000, 130,000 [ GIS_PARCEL_MUMBER
JEE :;i [ STATE_TOWMNSHIP _MUMBER
11 [s510 3,294,100 B5,500 3,256,800 5,636,400 CICESTREICT, MURIEER.
1z [511 468,700 70,500 1,063,800 1,603,000 [ STATE_ASSIGNED_DISTRICT_NU.
13 |512 235,800 235,800 [ SECTION_AMND_PLAT -
14 |s20 113,100 113,100 [ ROUTING_MUMBER
15 [543 40,000 40,000 [IFROPERTY_ADDRESS
16 |550 - - - [0 PROPERTY_ADDRESS_CITY
jz 233 £S00 21 2,200 Z3TMN) [1PROPERTY_ADDRESS_ZFIP_CODE |
19 |s20 - -
-0 |san : = Drag fields between areas below:
21 |6BS 1,400 1,400 W Report Filber T Column Labels
22 |e99 - STATE_ASSI... ~
23 |iblank)
24 |Grand Total 4,041,400 177.100 5.906, 300 11,124,800 T Fow Labels = e
25 PROPERTY_C... ™ Sum of CURR... =
=
e [ Defer Layout Update
4 4 » Bl 1 Aand File Chart Data Tewt Ton Callimns Sheats N il if T Tl
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2 Microsoft Excel Quiz 2

Quiz 2, Question 1:

Graphs, Pivot Tables, and the Subtotal command are all tools
used to help summarize and display data.

1. True

2. False
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% Microsoft Excel Quiz 2

Quiz 2, Question 1:

Graphs, Pivot Tables, and the Subtotal command are all tools
used to help summarize and display data.

Answer:

True

Each tool can be used to display and summarize data, but
depending on your purpose, one tool might be better than the

other.
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; ; Microsoft Excel Quiz 2

Quiz 2, Question 2:

The only mathematical operation that can be used in a Pivot is a
summation.

1. True

2. False

s



Microsoft Excel Quiz 2

Quiz 2, Question 2:

The only mathematical operation that can be used in a Pivot is a
summation.

Answer:

False

Pivot Tables can do a variety of operations such as: sum, county,
average, max, min, product, etc..
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LESSON 3:

DATES IN EXCEL
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Dates in Excel

'i_f/: Home Insert Page Layout r ﬂ H Whether you type
‘ij 0izut calibri - - Home Insert Page Layout 8/2 2/20 10’ 22—Aug-
Paste o . -\l % cut Calibri
L rorma anter S ) G - 2010, or even August
. Format Painter = = .
Iea - : f:;| s,fzzf’zuzu — Clipboard Font 22’ 2010’ |t's a”
: 33 ~ J= | 40412 .
e A~ fsaal c [ o stored in Excel as
; L =m serial number 40412.
q

e Storing dates as numbers allows for date arithmetic which is
extremely useful for project management.
e Examples:
e Number of days between two dates.
e Number of workdays between two dates.
e The date after a number of workdays.
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Dates in Excel — # of Days

Imagine that today is June 9, 2010. Your vacation starts on
Aug. 21, 2010. You want to find out how many days there

are until vacation.
e Type =A3-A2 into an empty cell
e The resultis that there are 73 days between the two

dates. paste Bz U@ [EEeEE =

Clipboard ] Font Alignment

sUM v X v J‘:’:| =A3-A2( 3
A B C D E F G H I

————=a
6/9/2010
—
8/21/2010}—
— =n

B \

L=y BN R SRR N R
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% Dates in Excel — # of Workdays

e It'sstill June 9, 2010, and your vacation still starts on August
21, 2010, but now you want to find how many workdays

until vacation.
e Type =NETWORKDAYS(A2,A3) into an empty cell
e The resultis that there are 53 days between the two

dates.

Tables IHustrations Charts

SM w (2 X ﬁ:| =NETWORKDAYS(A2,A3)( 3
A B C D E F G H I
1
————%
2 | 6/9/2010
e — |
3 8/21/2010
———— =&
4

1
I |:NI:—I"INGRKDAYS|{.&2,.&3}

L= R |

2=
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Dates in Excel — Exact Date

SUM ~ (% % « f | =WORKDAY(A2,A3,A4:46) ( 3

*Imagine that you have = ; - = - . ;

apprOXImately 80 1 Date Description

workdays in which to . on
complete a project that | 1/ix/aoio Heica

begins on 12/31/2010’ : 2/15/2010] Hoiida

and you need to find the ! oreoavazazazss)
project end date. \

2 |4,fzz,f201§_|

e Type into an empty cell: =WORKDAY(A2,A3,A4:A6)

e Where

e Cell A2 is the project beginning date
e Cell A3 are the number of days needed to complete the project
e Cells A4:A6 holidays that likely to affect the calculation

e The project must be completed by 4/22/2011.
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' Microsoft Excel QUiZ 3

Which function would you use to find the number of workdays
between two dates?

1. WORKDAY
2. NETWORKDAYS

3. DATEIN
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............
T

i) Microsoft Excel Quiz 3

Which function would you use to find the number of workdays
between two dates?

Answer:

NETWORKDAYS
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LESSON 4:

IMPORT A TEXT FILE
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Sample Data

e |In order to complete these hands-on exercises,
vou will need the OILGAS.txt file downloaded to

your computer.

e While we are using this file in our examples, the
functionality discussed could be used with other
files created by you or generated by your CAMA
system.
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%3 Import Text File Into Excel

Open a blank excel spreadsheet. Click the Office
Button.

Clic

k on OPEN (or use the icon button)

Navigate to where you saved the OilGas.txt file

ano
Hig
clic

open it.
nlight the filename you want to open and

< OPEN.

A TEXT IMPORT WIZARD box will open

pro

mpting you to select how you want the data

to appear when viewed using excel.
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Import Text File Into Excel

Text Import Wizard - Step 1 of 3 K E

e The Wizard allows you to R S T

If this is correct, choose Mext, or choose the data type that best describes your data.
riginal data byps

C h 0 O S e C O I u m n fo r m a t S’ Chaose the file bype that best describes your data:

" Delimited - Characters such as commas or tabs separate each field.

%+ Fixed width - Fields are aligned in columns with spaces between each field.

provides data preview, and oo = meo
other advanced settings.

| 437 : GEM Urited States =l

Preview of File Y\iotfilpSOpw, shared. skate.in.us\DLGFHOMEMMcdermott\Excel Presen. . \OILGAS. bxk,

- . . 1 FTLENAME: OILGAS County Humber: l4County Description: DAVIESS -
Z POE?ELZ000 OILJOHN DAVIS Operator 00000000000001
I C O n Ixe I 2 p077522000 0ILY HOWLING Ovner 000Z20000000000
4 po77?s00000 OILA. EILLION Ovmer oo0Zoo0o0oo0o0o
. . S pOs7E1LZ000 OILCOREIN ovmer 0001000000001 -
— Start import at Row 2 click : >
V4

Einish |

P | = Back |
Next
— Using the file specifications in e s o —

This screen lets vou select each colurn and set the Data Format.

rColumn daka format

5 O I A C 2 6’ m Ove b re a k I i n e S tO f_ ;f:zteral‘é 'riﬁqn;:ianl' cnnl\-'erts numetic values to numbers, date values to dates, and all
L g values ko bexk,

desired positions, when done | cwmmamn =]
click Next

— Click General for data format

rDaka previ

sn=ral General General
County Number: l4County Description: DRVIESS =
. . . OILJOHN DAVIZS Dperator 000000000000 01Z1
OTLW MOWLIMNG rmer O0ozZza0000a000aan
o CI I C k O n F I n I S h 0ILA. KILLION Pwner 0002000000000000
. OILCOREIN Prmer 0001200000000111] ~ |
vl

Cancel < Back [ext = | Einish I




MY Contact the Department

Eric Bussis — Director
e Telephone: 317.232.3759
 E-mail: erbussis@dlgf.in.gov

Megan McDermott — Asst. Director
e Telephone: 317.232.8347
e E-mail: mmcdermott@dIfg.in.gov

Data Division General Mailbox: data@dlgf.in.gov

Web site: www.in.gov/dlgf
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